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Рис.1. Прилад типу ДП-6А 
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ВИЗНАЧЕННЯ ДЕФОРМАЦІЇ ГВИНТОВОЇ ПРУЖИНИ 

Мета роботи 

Побудова характеристики пружини 𝜆 = 𝑓(𝑃) на підставі виконаних 

розрахунків, та за даними, що отримано експериментально; експеримента- 

льна перевірка формул для визначення деформації (осади) пружини; визна- 

чення максимальних напружень, які діють у витках пружини. 

Прилади та обладнання 

При виконанні лабораторної роботи може використовуватись таке об- 

ладнання: прилад типу ДП-6А (рис.1) для визначення характеристик гвинто- 

вих пружин стискання (розтягування); штангенциркуль, комп’ютер. 

Практичну частини лабораторної роботи, студенти можуть виконувати 

за допомогою лабораторної установки ДП-6А, або/та числової моделі гвин- 

тової пружини, що завантажено в програмний пакет скінчено-елементного 

аналізу ANSYS. Використання цифрової моделі надає можливості не тільки 

задавати гнучкі режими навантажень, але і проводити заплановані вимірю- 

вання дослідницького характеру – наприклад досліджувати пружини з різ- 

них матеріалів, зі змінним шагом або змінним діаметром прутка. 
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Теоретичні положення 

Пружина є елементом конструкцій машин, який слугує для передачі 

пружно-поступального руху деталям, вузлам та механізмам. Ця дія обумов- 

лена властивістю накопичення та поглинання механічної енергії. Також 

пружина може використовуватися в різних конструкціях для гасіння коли- 

вань. 

Гвинтова пружина - найпоширеніший у техніці тип пружини. Найчас- 

тіше їх виготовляють із сталевих стрижнів (дроту) круглого поперечного 

перерізу. Гвинтові пружини в робочому стані піддаються процесу деформа- 

ції, тобто розтягуються або стискаються. Цей пружний елемент знайшов 

найширше застосування в машинобудуванні та автомобільної промисловос- 

ті. Гвинтові пружини можуть бути циліндричної або конічної форми, з пос- 

тійним діаметром витків, або зі змінним діаметром. Пружини зі змінним ді- 

аметром та шагом витків, застосовуються наприклад, в амортизаторах. 

До гвинтових пружин відносяться, наприклад, клапанні пружини. Во- 

ни призначені для закриття клапана і повернення його в сідло після того, як 

з нього буде знято навантаження розподільчого валу. Крім того, пружина 

клапана забезпечує утримання клапана в закритому положенні, що забезпе- 

чує щільну посадку клапана в сідлі. В результаті дії навантажень, початкова 

висота і жорсткість пружин у процесі її роботи зменшуються. Відповідно до 

технічних вимог на капітальний ремонт двигунів, значення пружності кла- 

панних пружин, тобто зусилля стиснення до довжини, яка відповідає поло- 

женню «відкритого» та «закритого» клапана, суворо регламентовані. У цен- 

трах СТО дефектація клапанних пружин проводиться за допомогою спеціа- 

льного приладу. Схожі випробування виконуються і в цій роботі. 

 

Рис.2. Гвинтова пружина 
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В лабораторній роботі досліджуються пружини, які піддаються  дії 

лише стискаючих сил (тобто пружини стискання). Для того, щоб виконати 

розрахунок пружини на міцність, необхідно знати, які внутрішні сили вини- 

кають в матеріалі прутка, з якого виготовлена пружина. 

Щоб відповісти на це питання, необхідно розглянути схему дії зовні- 

шніх сил та виникнення внутрішніх зусиль у витку пружини (рис.3). 
 

Рис. 3. Схема навантаження витка гвинтової пружини 

Аналізуючи наведену схему, слід зазначити, що сила F корисного на- 

вантаження, з одного боку утворює в середині прутка перерізуючі напру- 

ження від дії поперечної сили Qy. З іншого боку, та сама сила F призводить 

до виникнення крутного моменту Мкр, оскільки лінія її дії не проходить че- 

рез центр площі поперечного перерізу прутка пружини. В результаті також 

виникають дотичні напруження. 

Таким чином, в результаті дії стискаючого (розтягуючого) зусилля, в 

поперечних перерізах прутка пружини виникають дотичні напруження зрізу 

і кручення, які можуть бути визначені по формулі 

𝜏 = 𝜏' + 𝜏'' =  
4F  

+ 
8FD 

= 
8FD 

(1 + 
d 

), (1) 
    

max 

де 𝜏' – напруження зрізу; 

𝜏'' – напруження кручення; 

D – середній діаметр пружини; 

πd2 πd3 πd3 2D 

F – осьова сила, прикладена до пружини; 

d – діаметр стрижня, з якого виконана пружина. 

Зазвичай 𝑑 ≪ 𝐷 (пружини з малим кроком витка), тому 

8FD 

𝜏max  = 
πd3 (2) 

Для таких пружин, у яких діаметр прутка значно менший за радіус ви- 
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 λ, мм 
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1 

3 λmax 

F, кг 

тка, можна знехтувати напруженнями зрізу, що є значно меншими у порів- 

нянні з напруженнями, які виникають від дії крутного моменту. 

Пружини стискання набули широкого поширення в техніці саме тому, 

що при відносно малих розмірах, витримуючи значне навантаження, дозво- 

ляють отримати значні переміщення. 

Отже, найважливішою характеристикою пружини є залежність її де- 

формації (осідання) від навантаження, що прикладається. Теоретичну вели- 

чину осідання пружини λ можна розрахувати, використовуючи інтеграл Мо- 

ра для визначення переміщень. Вважаючи, що витки пружини піддаються 

лише деформації кручення, можемо записати 
8FD3n 

𝜆 = , (3) 
Gd4 

де n – число витків пружини; 

G – модуль пружності 2-го роду (модуль зсуву) матеріалу пружини. 

Використовуючи поняття жорсткості пружини 
Gd4 

𝐶 = 
8D3n 

(4) 

можна записати 

𝜆 = 
F

 
C 

 
(5) 

Характеристикою пружини вважається залежність осідання λ пружини 

від зовнішньої сили F. Зазвичай цю залежність представляють у вигляді 

графіка (рис.4). 
 

Рис. 4. Результати визначення деформації пружини в залежності від 

навантаження: 1  теоретична залежність; 2   експериментальні дані; 

3  дані цифрової моделі 
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Максимальну осадку пружини, при якій витки пружини лягають один 

на одного (зникає зазор між витками) приблизно можна визначити за допо- 

могою залежності 

𝜆max  = 𝐻 − 𝑛𝑑 (6) 

де H – висота пружини у вільному стані. 

Порядок виконання роботи 

1. Побудова теоретичної залежності деформації пружини від прикладе- 

ного навантаження. 

Виконати обміри параметрів пружини за допомогою штангенциркуля, 

та результати занести у таблицю 1. 

Таблиця 1. Параметри пружини 

№ 

пп 
Назва параметра та одиниці виміру Позначення Величина 

1 Зовнішній діаметр пружини, мм D1  

2 Діаметр прутка пружини, мм D  

3 Розрахунковий діаметр витка пружини, мм 𝐷 = 𝐷1 − 𝑑  

4 Модуль пружності при зсуві, Н/мм2 G 8∙105 

5 Повне число витків, шт. 𝐾  

6 Робоче число витків, шт. 𝑛 = 𝐾 − 1  

7 Висота пружини, мм 𝐻  

 
Визначити граничні умови роботи пружини, а саме: 

- максимальну осадку 𝜆max= мм; 

- максимальне навантаження (за графіком) 𝐹max  = 𝐹(𝜆max)= Н; 

- максимальні дотичні напруження 𝜏max= МПа. 

Виконати розрахунки деформації пружини в залежності від величини 

навантаження, використовуючи  формулу  (3)  для  діапазону  навантажень 

0 ≤ 𝐹i ≤ 𝐹max . Результати розрахунків занести до таблиці 2. За отриманими 

значеннями F та λ побудувати графік (див. рис. 4.) (лінія 1 – червона). 

2. Експериментальне визначення величини осадки пружини в залежнос- 

ті від величини прикладеного навантаження. 

В залежності від способу організації проведення експериментальної 

частини лабораторної роботи, провести опитне визначення величини осадки 

пружини, використовуючи її натурну модель на установці ДП-6А, або (та) 

цифрову модель в програмі ANSYS. Результати експериментального визна- 

чення величини осадки пружини також занести до таблиці 2, та відкласти їх 

на графіку (див. рис. 4.). 
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Таблиця 2. Результати теоретичного 

та експериментального дослідження 

Навантаження 

𝐹i, кг 

Величина деформації Розбіжність 

теоретична  т експериментальна  е  e 
 e          т 

e 

100% 

    

    

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
    

 

3. Проаналізувати отримані результати і зробити висновки 

У висновках по лабораторній роботі, студент має проаналізувати, який 

характер має залежність деформації гвинтової пружини від величини прик- 

ладеного навантаження. 

Опис моделі гвинтової пружини та методика проведення 

експериментального дослідження 

 При використанні лабораторної установки ДП-6А 

Прилад (рис. 1) складається з литої основи 1,  до  верхньої площини 

якої кріпиться редуктор 2 та трубчаста колонка 3. На колонці змонтовано 

робочу рамку та вимірювальні пристрої. Редуктор складається з черв'яка, на 

валу якого закріплений маховичок 4, черв'ячного колеса та ходового гвинта,  

який розташовано всередині колонки. При обертанні маховичка, ходовий 

гвинт переміщає вздовж вертикальної осі приладу гайку-втулку 5. На втулку 

5 посаджений кронштейн 6 який можна переміщати вручну вздовж втулки і  

фіксувати в потрібному положенні ручкою зажиму 7. 

Переміщення та встановлення кронштейна здійснюється при переході 

від роботи з пружинами розтягування до роботи  з  пружинами  стискання, 

або навпаки. На кронштейні закріплений нижній гачок 8 пружин розтягу- 

вання і верхня ступінчаста опора 9 для пружин стискання. Робоча рамка 

складається з верхньої 10 і нижньої 11 траверс, з'єднаних між собою двома 

плоскими металевими смугами 12. На верхній траверсі закріплена попере- 

чина 13, в нижній частині якої є дві кульки, які упираються в плоску вимі- 

рювальну пружину 14. Верхня траверса прикріплена до металевої пластини,  

яка закріплена на колонці і має верхній гачок 15 для кріплення пружин роз- 

тягування. 

Нижня траверса має два отвори, в які входять із зазором два напрямні 

штифти, закріплені на планці, яку встановлено на верхній частині корпусу 

редуктора. 
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У верхній частині приладу закріплений кронштейн 16 з індикатором го- 

динникового типу 16, головка якого упирається у вимірювальну пружину 14. 

При переміщенні кронштейна, встановлені на опорах або гачках пру- 

жини навантажуються зусиллями, які їх стискають або розтягують. Ці зу- 

силля передаються робочій рамці, яка деформує заздалегідь відтаровану за 

навантаженням вимірювальну пружину, і далі – на індикатор, відхилення 

стрілки якого визначає зусилля, що діє на пружину. 

Деформацію пружин визначають за допомогою масштабної лінійки 17 

і шкали 18 на кронштейні. Точність вимірювання становить 0,1 мм. 

Для випробування пружин розтягування кронштейн 6 переміщують і  

закріплюють у верхньому положенні. На гачки підвішують пружину, та обе- 

ртанням маховичка злегка навантажують її (так, щоб відхилення стрілки ін- 

дикатора не перевищувало 3-5 поділок). Фіксують на масштабній лінійці 

показання, а потім навантажують пружину заданим зусиллям (за показанням 

стрілки індикатора) та визначають осадку 𝜆е, фіксуючи зміну показань мас- 

штабної лінійки та ноніуса. 

Збільшуючи навантаження F, та визначаючи відповідну деформацію 

𝜆е, складають таблицю та будують графік. 

Для випробування пружин стискання, кронштейн опускають у нижнє 

положення, пружину встановлюють на опорах. Випробування проводиться 

аналогічно до того, що описано раніше. Єдина принципова відмінність по- 

лягає в тому, що перед початком випробувань визначають значення макси- 

мальної осадки пружини 𝜆max, та максимальну величину зусилля 𝐹max , до 

якого може бути навантажено цю пружину. 

Порядок оформлення звіту щодо виконаної роботи, можна подивитися 

в розділі «виконання роботи». 

 При використанні числової моделі гвинтової пружини 

1. Підготовка проекту . 

1.1. Підготовка робочої директорії (папки) для зберігання файлів ла- 

бораторної роботи. 

1.2. Запуск Workbеnch. Створення нового проекту: вказати робочу ди- 

ректорію та унікальне ім’я файлам. 

Пуск → Програми → AnsysWorkbench → Save as → папка, ім’я  

Завантажена платформа має головне меню, панель інструментів 

(Toolbox) та схему проектів (Project Schematic) . 

1.3. Вибрати систему одиниць виміру – систему СІ (рис.5). 

Main menu → Units → Metric  



10  

 
Рис. 5. Вибір системи одиниць виміру 

 

1.4. Вибір типу аналізу. 

Toolbox → Analysis system → Static structural  

В даній роботі вибираємо аналіз статичної міцності конструкції. При цьо- 

му в полі вікна схеми проектів активізується меню даного проекту, яке включає 

такі позиції: 

• Engineering Data – підпрограма вибору механічних властивостей мате- 

ріалу; 

• Geometry – підпрограма побудови геометричної моделі; 

• Model – підпрограма побудови СЕ-сітки та вибору граничних умов; 

• Setup and Solution – задання опцій для процедур розрахунку; 

• Results – візуалізація отриманих результатів. 

2. Задавання механічних характеристик 

Project schematic → Engineering data (клік лівою кнопкою миші двічі), 

або клік правою кнопкою миші по позиції Edit у вспливаючому вікні  

Активізуються декілька вікон: 

• в першому – бібліотека матеріалів; 

• в другому – вибір характеристик конкретного матеріалу; 

• в третьому – перегляд заданих у бібліотеці властивостей для обрано- 

го матеріалу. 

Виберемо в бібліотеці матеріал Structural Steel («Конструкційна 

сталь») (рис.6). 
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Рис. 6. Вікно аналізу Engineering Data 

 

Зауваження: якщо вікно аналізу Engineering Data приховане, то: 

Main menu → View → Reset → Workspace  

Повернення до меню проекту: 

Main menu → Return to Project  

На наступному етапі можна за завданням викладача або завантажити модель 

пружини (рис.7), або побудувати її самостійно. Після імпорту геометричної 

моделі потрібно перейти до п.4. Порядок побудови моделі пружини в Design 

Modeler наведено в п.3. 

 
 

Рис. 7. Завантаження моделі пружини 
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3. Побудова геометричної моделі. 

3.1. Активізація вікна підпрограми Design Modeler, в якому відбува- 

ється побудова геометричної моделі (рис.8): 

Project schematic → Geometry (клік лівою кнопкою миші двічі), або клік пра- 

вою кнопкою миші по опції New geometry у вспливаючому вікні  
 

Рис. 8. Активізація вікна підпрограми Design Modeler 

3.2. У вкладці вибрати розміри в мм. 

Main Menu → Units  

Design Modeler включає: 

• Main Menu – головне меню; 

• Tree Outline – дерево геометричної моделі; 

• Graphics – вікно виводу графіки. 

Головним засобом побудови геометричних моделей є використання 

ескізів (Sketchs). 

3.3. Розглянемо побудову ескізу пружини. 

3.3.1. У дереві  моделі  TreeOutline  за  робочу  площину  виберемо 

ХPlane. 

3.3.2. Створюємо новий ескіз Sketch1. 

Main menu → Newsketch  
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3.3.3. Активізуємо Sketch1 та задаємо для нього ХYPlane як робочу 

площину при побудові зображення: 

Main menu → Treeoutline → Sketch1 (правою кнопкою миші) → Look at face   

3.3.4. Побудова кола із розміром, який наближений до зовнішнього ді- 

аметра проволоки пружини: 

Main menu → Treeoutline → Sketchіng → Draw → Circle  

3.3.5. Виставляємо виноски розмірів: 

Sketchіng → Dimensions → General  

Виносимо стрілки розмірів. Їх точні значення проставляємо у вікні 

Details View. D - діаметр проволоки пружини, H – середній діаметр 

пружини (рис.9). 
 

Рис.9. Details View. Розміри пружини 

3.3.6. Повертаємось в режим моделювання Modeling. Створюємо но- 

вий ескіз Sketch2 (рис.10). 

Main menu → Newsketch  
 

Рис. 10. Створення нового ескізу 

3.4. Побудова осі пружини (рис.11). Повертаємось в режим креслення. 

Main menu → Treeoutline → Sketchіng → Draw → Line  



14  

 

Рис. 11. Побудова осі пружини 

3.5. Виставляємо виноски розмірів: 

Sketchіng → Dimensions → General  

Розмір відповідає висоті пружини в недеформованому стані. 
 

Рис. 12. Простановка розмірів V3 – висота пружини 

Повертаємось в режим моделювання Modeling. 
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На панелі меню вибираємо кнопку Sweep (рис. 13) для побудови ескізу 

пружини, а у вікні Details View задаємо параметри побудови. Лінійне видавлю- 

вання 

Рис. 13. Операція Sweep 

Протяжка уздовж контуру Sweep дозволяє отримати об’єм шляхом пе- 

реміщення базового ескізу уздовж напрямної кривої. 

Основні параметри команди: Profile – базовий ескіз для створення 

об’єму; Path – ескіз з направляючою кривою; Alignment – спосіб вирівню- 

вання контуру базового ескізу по відношенню до напрямної кривої. За замо- 

вчуванням задається як Path Tangent – контур зберігає первісну орієнтацію 

по відношенню до напрямної кривої. Значення Global Axis зберігає орієнта- 

цію контуру щодо осей координат; Scale – масштабний коефіцієнт. Дозволяє 

масштабувати контур базового ескізу в кінці направляючої кривої; Twist 

Specification – параметр, що дозволяє задавати опції при повороті контуру 

базового ескізу навколо направляючої кривої. За замовчуванням даний па- 

раметр відключений (No Twist). Він може приймати значення Turns  – в 

цьому випадку задається число обертів навколо направляючої кривої або 

Pitch – задається довжина шляху, пройденого контуром при повороті. Зна- 

чення для Turns та Pitch можуть бути негативними – це означає поворот за 

годинниковою стрілкою. 

Необхідно відзначити, що контур і спрямовуюча крива повинні пере- 

бувати в різних ескізах. Базовий ескіз може містити скільки завгодно як ко- 

нтурів (у тому числі і незамкнутих), так і окремі точки. Напрямна крива мо- 
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же бути замкнутою, але вона обов’язково має бути єдиним контуром в ескізі. 

В нашому  випадку  Profile  –  базовий  ескіз  для  створення  об’єму 

Sketch1, Path – ескіз з направляючою кривою це Sketch2. 

Вікні Details View задаємо параметри пружини. Крок (Pitch) 4 мм, ма- 

сштабний коефіцієнт (Scale) 1. 
 

Рис. 14. Параметри пружини. Крок. 

Generate – фіксуємо всі зміни при побудові частини моделі. Одержує- 

мо тривимірну модель пружини. (рис. 15). 
 

Рис. 15. Тривимірна модель пружини. 

4. Повертаємось в головне меню та обираємо пункт Model 

4.1. Активізація вікна підпрограми Mechanical. 

Project schematic → Model (лівою кнопкою миші двічі), 

або правою кнопкою миші по опції Edit  
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Подальша робота відбувається в цьому вікні, яке має Головне меню 

(Main Menu), дерево моделі (Outline), вікно параметрів (Details of …) та ві- 

кно виводу графіки (Geometry). Дерево моделі надає доступ до всіх параме- 

трів: геометрії, матеріалу, системи координат, СЕ, граничних умов та чисе- 

льного алгоритму. 

4.1.1. Cтворення СЕ-сітки. 

4.1.2. Автоматична побудова СЕ – сітки: 

Outline → Mesh → Generate mesh  

4.2. Для того, щоб задати граничні умови, обираємо 

Outline → Static Structural  

В стрічці з’являються пункти: Inertia («Сили інерції»), Loads («Наван- 

таження»), Supports («Обмеження»). 

Задаємо варіант жорсткого закріплення нижньої поверхні пружини: 

Main menu → Static Structural → Supports → Fixed supports   

Використовуючи клавішу Ctrl та Face Element  віділяємо поверхню 

для закріплення. Для повороту, збільшення-зменшення використо- 

вують кнопки . 

При виділенні елементи зеленого кольору, після виконання команди 

стають фіолетового кольору (рис.16). 
 

Рис. 16. Завдання жорсткого закріплення 

4.3. Для завдання навантаження валу справа поздовжньою силою не- 

обхідно обрати: 

Main menu → Static Structural → Loads → Force  
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Обираємо необхідну поверхню зверху, задаємо поздовжню силу за її  

компонентами. Після виконання команди поверхня стає іншого ко- 

льору (рис.17). 
 

Рис. 17. Завдання навантаження 

Модель готова до розрахунків. Натискаємо Save – зберігання готового 

проекту. 

4.4. Вибір параметрів розрахунку: 

Outline → Solution  

З’являються пункти параметрів розрахунку: Deformation («Перемі- 

щення»), Stress («Напруження») та інші (рис.18, 19). 

Обираємо Stress Shear, у вікні параметрів (Details of …) обираєо XY 

component «Дотичні напруження в площині XY»; Deformation Total 

«Сумарні переміщення» (рис.17). 

Outline → Solution (A6) → Insert → Stress → Shear 

Outline → Solution (A6) → Insert → Deformation → Total   

Рис. 18. Вибір параметрів розрахунку Deformation 
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Рис. 19. Вибір параметрів розрахунку Stress Shear 

4.5. Натискаємо кнопку Solve («Розрахувати»). 

4.6. Після розрахунку будуть наведені поля результатів. 

Записуємо результати в таблицю. 

Натискаємо кнопку Solve («Розрахувати»). Отриманий результат 

(рис.20) записуємо в таблицю. 
 

Рис. 20. Результат розрахунків. Переміщення 
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Можемо переходити до наступного значення навантаження. 

Повертаємось до п. 4.3 та задаємо наступне за кроком навантаження. 

Main menu → Static Structural → Loads → Force  

4.7 Для перерахунку результатів преходимо до Solution (А6) (рис.21). 

Outline → Solution (A6) → Evaluate All Results   
 

Рис. 21. Перерахунок результатів 

Отримані результати заносимо в таблицю. Операцію повторюємо для 

всіх заданих викладачем значень навантажень. По закінченню розрахунків 

будуємо графік. 

 

 
Контрольні запитання 

Слід дати відповіді на такі питання: 

1. Яких деформацій зазнає виток пружини під дією крутного моменту і по- 

перечної сили? 

2. Які напруження виникають у поперечному перерізі витка пружини? 

3. Як вони визначаються? 

4. Який можна зробити висновок, аналізуючи формули (1) та (2)? 

5. Чому пружини стискання набули широкого поширення в техніці? 

6. Чи можна експериментально збудувати характеристику пружини? Якщо 

так, то як це слід зробити? 

7. Коли напруження у пружині стискання досягнуть максимальної величи- 

ни? 

8. Як визначити максимально можливі напруження в пружині стискання, 

використовуючи графік залежності осадки пружини від навантаження, і  

знаючи геометричні параметри пружини? 
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